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 فني طباعة وتغليف 

 

 : إعداد الأصول الطباعية بالأنديزاين الوحدة

 المادة التعليمية الخاصة بالطالب

 مخرجات التعلم المتوقعة :  
 يحدد البرامج المستخدمة لإعداد الأصول الطباعية    1
 ينفذ صفحة / صفحات ببرنامج الأنديزاين  2

 .  يقيم اداءه الخاص ويخطط لتحسينة -3
 

 
 

هو برنامج للنشــر المبتبي من شــربة أدوبي. ويمبن    InDesignأدوبي إنديزاين  

والمجلات والمنشــورات والملصــقات وايرها من اســتخدام هذا البرنامج لتصــميم ونشــر البتب 

لتنســيا النصــوص هو برنامج    Adobe InDesignدوبى إنديزاين  أشــبال المطبوعات. إ

يمبن  ومن إنتاج شـربة أدوبي.    والأخراج الصـحفى ويتميز بالبسـاطة وسـةولة التعامل معه وهو

مثل الملصـقات والنشـرات والبتيبات والمجلات   أنواع مختلفة من التصـميماتاسـتخدامه لإنشـاء  

 والصحف والعروض التقديمية والبتب والبتب الإلبترونية. 

، حيث يقومون بإنشــاء لهالمســتخدمين الرسيســيين    والمنفذينيعتبر مصــممو الجرافي   و

صـدر إلى والإنديزاين يالمنشـورات الدورية والملصـقات والوسـاسط المطبوعة.  وتنفيذ  وتصـميم  

 .قات بتاب النشر الإلبتروني لإنشاء بتب إلبترونية ومنشورات رقميةتنسي

 
 
 

 

 جميع حقوق الطبع محفوظة لوزارة التربية والتعليم والتعليم الفني 
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 الحاسبـ الاهتمام بنظافة المبتب وسطح المبتب الخاص بجةاز 1

 ـ تابد من سلامة توصيلات البةرباسية للاجةزة المختلفة 2

 ـ لاتستخدم الدبابيس او المسامير لتثبيت الاسلا  الى الحاسط او المبتب3

 ـ نظم الاسلا  حتى لاتدوسةا الاقدام وبذل  لاتضع الاسلا  اسفل السجاد او الاثاث4

 ةـ تابد من اجةزة البمبيوتر انةا تعمل فى حالة جيد5

 ـ استخدم مثبت للتيار تفاديا لاى زيادة فى الاحمال وبل  للمحافظة على الاجةزة6

ــ مسـتوى البرسـى الذى يتم الجلوس عليه يبون مناسـب بحيث يبون مسـتوى اليد فى نفس  7 ــــ

 مستوى لوحة المفاتيح وعدم انحناء الرأس باتجاه لوحة المفاتيح

ــاشـــة 8 ــ الابتعاد عن شـ ــــــ

ســـم   50الحاســـب بمســـافة  

 وتجنب النظر المستمر لةا

ــ اختار نوعية برسى جيدة 9

ــتوى   ــند فى مس ــع مس ووض

تــحـــت   الــمــفـــاتــيــح  لــوحـــة 

 الرسغين

ــ اســـتخدام فلتر على 10 ــــــ

ــرار  ــة لتجنب اضــ ــاشــ الشــ

الاشـعة عند الجلوس لفترات 

 . طويلة

 : يحدد البرامج المستخدمة لإعداد الأصول الطباعية المخرج الأول  

 قواعد الامن والسلامة إثناء استخدام البمبيوتر
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 فني طباعة وتغليف 

 

 

صـول المسـتخدمة في العملية الطباعية  الأ

 :  وهماتنقسم الى نوعين أساسيين  

ــ الأ1 صول التي تنتج  وهى الأ:    صول الرقميةــ

برامج التصــميم الموجودة بالبمبيوتر    لالمن خ

صـور المخخذذة نترنت وبذل  الالأأو عن طريا  

 الباميرات الرقمية.بواسطة 

أي تل  التي يراد إجراء  :    صول الماديةــــ الأ2

ات المســـــح ا لبتروني لةـا، والتي يمبن  لإعمليـ

  : للعديد من المعايير بما يليتصنيفةا طبقا 

 :  أنواع   ة ث لامن حيث طبيعتةا الى ث ❖

     خطية   أ ـ

               مستمرة الدرجاتب ـ  

 مرببة  ج ـ 

 :  وان الى نوعين لألمن حيث ا ❖

                       اللون  ة أحاديأ ـ 

 لوان  لأا ة متعددب ـ  

   :  من حيث نوعية الدعامة فيتم التصنيف على أساس ❖

                        أصول عابسةأ ـ 

 شفافة أصول ب ـ  

   :  بةا  ةصول طبقا للطريقة المنفذلأتصنيف ا ❖

                  أصول تم تنفيذها يدويا أ ـ 

                      أو فوتوارافيا ب ـ 

 أو رقميا ج ـ 

 

 الأصول الطباعية
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 فني طباعة وتغليف 

ــول الخطية    أ ـــــــ ــول  لأتحتوي ا:  الأص ص

الخطية على مســـاحات مصـــمتة أو خطوط 

على  واحتواسةـاأمتنوعـة أو ذات تـخثير نقطي  

ة أو ظةت ة.    للاشـــــيرات متنوعـة خطيـة. وبمعنى مخر، عـدم احتواسةـا على درجـات بينيـ متـداخلـ

تـنـــدمج   أن  ويـمـبـن 

ول مع  لأصـــــهـذه ا

ــواء في   بعضــةا س

ــاسي أو  ثن ــدمــاج  ان

ر ثـ وأبـ ــول  لأا،  صـــ

أن الـ يـمـبـن  خـطـيـــة 

تنفـذ بلون واحـد أو 

ــعـــددة،   ــت م ــوان  أل

أن  مـبـن  يـ بـــذلـــ  

تبون في صـــــورة  

ــفافة، ويمبن تنفيذها يدويا بخلوان الجوا  أو  ــة أو شــ أو خلوان زيتية  بخلوان ماسية أو  بعابســ

    .فوتوارافيا أو م التحبير أو باستخدام البمبيوترلاخقب

ــ    وهي تل  الأصـول التى يحتوى بل منةا على سـتمرة : الأصـول ذات الدرجات الظلية الم  ب ــــ

ودرجــاتــه أو على عــدة لون  

ذه الألوان  ألوان مع ظلال لةـ

ــ ال ــة درجــات  ، وهــذه  الظلي

حـيـــث   الـبـثـــافـــة  مـخـتـلـفـــة 

درجـــات   عــلــى  تــحــتــوى 

معتمة ودرجات متوسـطة  

ة، اتحـ ات فـ ة ودرجـ افـ   البثـ

يمبن أن تنفـذ بلون واحـد أو و

ة إلى تبوين نقطي    ألوان متعـددة ة المختلفـ اج لتلـ  الأصـــــول بتحويـل الـدرجـات الظليـ ويتم الإنتـ

ــطة البثافة نقطا  بحيث تمثل المناطا الظلال البامل نقطا ببيرة متداخلة ويمثل المناطا المتوســ

 تنقسم إلى من حيث طبيعتةا أنواع الأصول
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 فني طباعة وتغليف 

متوســطة المســاحة ومنفصــلة عن بعضــةا وتمثل المناطا الفاتحة نقطا صــغيرة جدا ومتباعدة،  

 .والبتابات المستمرة الدرجاتواللوحات الفنية الصور الفوتوارافية والرسوم :  مثل

أصــول خطية  على بلا من  وهي تل  الأصــول التى يحتوى بل منةا    الأصــول المرببة :ج ـــــــ    

من خطوط وظلال المربب  فى أصـل واحد. فيبون الأصل    سـتمرةوأصـول ذات الدرجات الظلية الم

  ويمبن أن تنفذ  أو رســوم . صــورة فوتوارافية مضــافة إليةا بتاباترســم ماسي أو   -:  معا مثل

مور  لأصـــــل من الأمر أن تحديد نوع الأوفى حقيقة ابلون واحد أو ألوان متعددة  هذه الأصـــــول

عطاء مواصــفات  لإالةامة  

بمــدخلأا أو  لاصـــــــل  ت 

وامر التشـغيل  لأمعطيات  

الخاصــة بإنتاج الصــور 

د  الممســـــوحـ ة وتحـديـ

الصـــــحيح  البرنــامج  

 لتنفيذ هذه الأصول.

ــللأجودة ا ❖ توجـد     :صـــ

 : ث درجات من الجودة وهيلاث الأصول فى

وهي أصول معيبة حيث تبون اير محددة المعالم نتيجة لتلفةا  :  نتاجللإ  أصول اير قابلةـــــ  1 

يمبن تحسين جودتةا لدرجة ببيره بما   لاصول  لأأو انبسارها من فعل الزمن أو التناول، وهذه ا

 .زمة وهذا يعنى تبلفة عاليةللافي أعمال الرتو  والتصحيحات ا لاا أنةا تتطلب وقتا طوي

نتاجةا  لإصـول التي يمبن إجراء عمليات الرتو  وتصـحيحةا  الأأي   :  تاجلإنأصـول قابلة لــــــ  2

 .التفاصيلبتل  التي تحتوي على مسحة لونية أو تحتاج الى زيادة 

تحتاج الى إجراء أي معالجات للصـورة   لاصـول التي  الأتعتبر   :  نتاجلإصـول الجاهزة لــــــ الأ3

 نتاج.لإأثناء عمليات ما قبل الطبع مثل اجراء تصحيحات أو رتو  هي أصول جاهزة ل

على   (  بروشـــورمجلة / جريدة /  الأصـــول الطباعية   من    مختلفةد اعدأيتم توزيع    تدريب :

يطلب من بل طالب أن يقوم باختيار  ولصــــا  وال لقصلدوات المناســــبة  الأيتم توزيع  و  الطالب

وقصــةا ولصــقةا على ورقة    قابليتةا للإنتاجوالخطية والمســتمرة الدرجات والمرببة  صــول  الأ

 .بيضاء ويبتب نوعةا ومواصفاتةا
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 فني طباعة وتغليف 

 

 

   مثل :  تتنوع    منتجات الأصول الطباعية

 البتب. •

 المجلات والصحف. •

 الشعارات أو العلامات التجارية. •

 المطويات.  •

 الملصقات. •

 البنرات.  •

 علب البرتون.  •

 أبياس.   •

 مغلفات.   •

 قواسم الطعام.  •

باتلوجات.   •

البروت  

 الشخصية.  

 بروت الدعوة.  •

 لوحات المحلات.   •

   ملفات/ فولدرات.  •

 

 

 

 

 

 

 

 

 

 

 

 

 

 منتجات الأصول الطباعية
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 فني طباعة وتغليف 

وقد يبون ســــمي  او رفيع، افقي او  الخط : - 1

ــي، منحيا او مأر ــراا سـ ــاعد في  نبسـ ، ان الخط يسـ

فةو قد يحر    ىالطباع  تصـــميموتنســـيا ال  تنظيم

هو خط، ويمبن تعريف   لاا إن بل شــيء في الطبيعة أصــ  .او يســاراا   ســفل يميناا لأعلي او  لأالعين 

عديدة منةا الحس بالحربة داخل الفراغ أو حوله    ، وللخط وظاسفشبل ضيا جداا   هالخط على أن

ه ابع حربتـ ل العين تتـ درة على جعـ ددة من   وذلـ  لمـا للخط من مقـ ا  أنواع متعـ أينمـا اتجـه هنـ

نواع  لأف مخر  وهنا  تصـني  الخطوط منةا الخط المسـتقيم، الخط المتعرج، الخط المتقطع....ال،،

الخطوط الوهمية    الخطوط منةا الخطوط الحقيقية وهي المرســومة بشــبل واضــح وحاد، وهنا 

ــميم. ــبلين في التصــ ــتقيمة    المتبونة نتيجة التقاء شــ وللخطوط تعبيرات معينة فالخطوط المســ

والمتعارضــــة والمتعابســــة في    ســــتقرار، أما الخطوط المتقاطعةالاالناعمة تعبر عن الةدوء و

 هاتةا تعبر عن الحربة والحيوية والتفاعل.اتجا

حيث يقوم المصـمم في تصـميمة بوضـع بعض العناصـر لبي تعطي   الشـبل او المظةر : - 2

 مربعا او مثلثا او داسريا.لاا او والشبل قد يبون مستطي هيبل للتصميم

شــ  انةا تجذب انتباه المشــاهد او لاوهي من العناصــر الببيرة داخل التصــميم و البتلة : - 3

 ببيرة وذل  نظرا لتباين تل  العناصر الببيرة. القارئ بدرجة

ــالـة الطبـاعيـة ويجعـل أجزاء منةـا ذات    اللون :  -  4 لوان مختلفـة عن أيضـــــيف معني للرســـ

 الألوان لوان :لأن رسيسـين من ايمبن حصـرها ولبن هنا  نوعي  لاوهي عديدة أيضـا و  خري.لأا

حمر ومشـــتقاته  لأالســـاخنة وهي ا الألوانخضـــر، وهنا   لأومشـــتقاته، وا  زرقلأالباردة وهي ا

تقاته.  صـفرلأوا ية ث  الألوانو  ومشـ زرق .ومن درجاتةا أو لأصـفر، الأحمر، الأا  ثة هي :لاالرسيسـ

ــمىالأالألوان تنتج    مزج لونين مع بعض ــمى(  لأثانوية . اللون األوان   خرى والتي تس بيض يس

مع بعضــةا البعض، وقد    الألوانيتبون نتيجة مزج جميع    ســودلأأشــعة  وليس( لون، واللون ا

ــاسل عن  ــود بدرجاتلأا  الرمادية، إنةا مزيج من اللون  الألواننتســ   بيض.لأبثافات معينة وا  ســ

  .ت حسية بثيرة تثير في نفس المشاهد أحاسيس معينةلامدلولةا  الألوان

ا  معاا لا فالورق قد يبون   ىالطباع تصميمعنصر من عناصر ال الملمس :- 5 ا  او معتما   او ناعما

 او يحتوي

ــر،   علي نتوءات. ــتين هما :اللمس والبص ــر الذي يمتاز بخننا نحس به بحاس الملمس هو العنص

عطاء بل شـيء طبيعته  لإاسـتخدامه للتمييز بين أجزاء التصـميم    وتبمن أهمية هذا العنصـر في

مس بين أجزاء لاللسـطح الناعم، بما أن تنوع الم  الخاصـة فالخشـونة للسـطح الخشـن والنعومة

 حساس بالملل.لإعن ا التصميم يعمل على إعطاء التصميم حيوية أبثر ويبعده

القيمة الضـوسية، فالمنطقة المضـيسة  ضـاءة أو درجة  لإوهي درجة ا :)  Valueالقيمة   -6

ة المعتمـة، هـذا في ا  في التصـــــميم عـادة ا تبون أبثر قيمـة من المنطقـ ة، أمـا لاعلإمـ ات الملونـ نـ

بيض يشــبل أعلى قيمة، وبلما اقتربنا من لأســود فقط فإن الأوا  بيضالأالتي تســتخدم    الإعلانات

 ضوء. قللأسود نبون قد تدرجنا نحو القيمة الأا

 الطباعيةعناصر التصميم 
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توزيع العناصــــر في المســــاحة   هو:  التوازن  -1

البيضــاء، ويتحقا بتقســيم المســاحة البلية للصــفحة 

 إلى نصفين بواسطة محور طولي وهمي أو محور عرضي وهمي. 

يتصدر التباين الأسس الأخرى في تحقيا الجاذبية إلى الشبل أو المساحة،   :التباين    -2

تةا بالعناصــر الأخرى. وفي نفس الوقت يســةم في تخبيد العناصــر ذات القيمة في علاقا

دأ يجـب ألا يذثر في   ذا المبـ د إلا أن هـ خبيـ ة والتـ اذبيـ اين في تحقيا الجـ ة التبـ ورام أهميـ

وحدت الموضــوع أو المســاحة. وبذل  لا يجب الإفراط في اســتخدام التباين بحيث يذثر  

 أيضاا في وضوح الرسالة الاتصالية وسةولة قراءتةا ومتابعتةا. 

علاقة البمية بين العناصـر مثل المسـاحات والأبعاد أو العلاقة يقصـد به ال  : التناسـب   -3

ا   الحسـية بين درجات اللون أو الإعتام، مثال : نلاحظ أن النظر إلى المسـتطيل يحقا جذبا

 أبثر من النظر إلى المربع ولذا يفضل إنتاج الصورة وطباعتةا في شبل المستطيل.

ــميم اأ  :  الاتجاه  -4 ــاس لتصـ جذب   ههدف لمطبوعات، وبذل  فإنرتبط هذا المفةوم بخسـ

انتبـاه القـارئ إلى نقطـة البـدايـة وهي التي يتوفر فيةـا موقع البـدايـة الطبيعيـة للنظر 

ــر على  ــر الأهمية في توزيع العناصــ ــفحة المطبوعة وبذل  عنصــ والقراءة على الصــ

ا بمفةوم الحربة التي يحسةا القارئ.   الصفحة. ويرتبط أيضا

دوره في  ع  التنوعيختلف    :  التنوع  -5 ذي يقوم بـ اين يعني الاختلاف الـ التبـ اين، فـ ن التبـ

جذب الانتباه وتخبيد العناصـر بالنسـبة إلى بعضـةا، أما التنوع فإنه يضـفي على الصـفحة 

ة   ة والحربـ ة  والمطبوعـة الحيويـ ارئ نتيجـ ه في نفس القـ د تبعثـ ذي قـ ل الـ ة والملـ ابـ الرتـ

 التشابه في أساليب العرض والاستخدام للعناصر.

ــاليب المختلفة لتحقيا الترابط والتجانس  :  الوحدة -6 ــتخدام الأسـ ــد بالوحدة اسـ ويقصـ

 والانسجام بين عناصر الموضوع الواحد. 

تبـدأ الخطـة المنظمـة لتنفيـذ أى تصـــــميم بعمـل مواصـــــفـات للعمـل 

المطلوب وتحديد مقاس الصــفحة المناســب للتنفيذ ولذل  لابد من 

ــاسعةمعرفة   ــميمات الشـ ــات التصـ ــةر مقاسـ ــات الورق  و اشـ مقاسـ

 وتقاسيماته ومقاس مابينة الطباعة المستخدمة. وهذه المواصفات تبتب فى أمر العمل.

 يم المطبوعاتأسس تصم

 قياسات الورق
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،  نفيذ نشـر، أم تصـميم، أم ت  وتحديد نوع ووصـف المطبوع ، هل ههو  

  ووزن  أم طباعة، وبذل  حالة الطلب، عادي أم عاجل، بالإضافة لنوع

     ولون الورق ومواصفات الطباعة والبمية المطلوبة.

وزن الفرخ  ويتم دراســـة أوامر العمل وفقا لمعايير تصـــميم وإخراج المطبوعات، ويشـــمل ذل  

ــاحـات الةوام  نوع و ــاحـات الطبـاعيـة ومســـ ورق الغلاف والملازم الـداخليـة وترتيبةـا، المســـ

ــطور،  ــافات بين السـ ــطر والمسـ ــبال وأحجام الخطوط للعناوين والمتن، طول السـ والبعب، أشـ

ــماء الأجنبية، بتابة التواري،،  ــور، طريقة إيراد الأسـ ــبال والصـ ــر الجداول، والأشـ طريقة نشـ

 :  ية، وفقا لما يختيوالمراجع العربية والأجنب

 الالتزام بالمواصفات الأخلاقية والقانونية للنشر.  .1

 تحديد المواصفات القياسية والفنية لعناصر المطبوعات.  .2

 تحديد مواصفات أالفة البتب والمجلات.  .3

 تطبيا الاشتراطات الخاصة بالمواصفات القياسية لضبط جودة الطباعية.  .4

 ت. تحديد مسارات التشغيل لإنتاج المطبوعا .5

 تحديد البرامج والصيغ الرقمية الملاسمة للملفات الرقمية للمطبوعات.  .6

 ومواصفاتةا وبمياتةا. والتغليف ضبط عمليات الطبع، والتجليد،  .7

 فتح قنوات اتصال بين الجةات المستفيدة ووحدات الطباعة والنشر.  .8
 

 

الطّباعة والتصّـــميم الطّباعي لا تدوجد مقاســـات في عالم  

حـددة للتقيّـد بةـا، إنمـا بـالإمبـان على الـدّوام ابتـداع أفبـار   مد

 : على سبيل المثال إليه خلاقّة حسب الطّلب والحاجة

هي بروت بســيطة تعريفية  :   أو البروت الشــخصــية  " Business Cards"  بطاقات العمل  -

ملم للعرض   90 ةا عادةمقاســوووســاسل الاتصــال به،  للشــخص، بةا شــعاره واســمه ووظيفته

تعارف  ولبن هنا  من يتحذملم للارتفاع،   55و من   أو مقاس ايره  نصــف المقاس التقليدي المد

 باب تحقيا نعومة أبثر للبطاقة.

هو مطبوعة ورقية تبون خاصـة بعرض سـلعة أو :  أو البروشـور  " Brochuresالمطويات "   -

مبـان أو خـدمـة أو منتج ومـا إلى ذلـ  وتبون ورقـة مطويـة لتبون ورقتين أو ثلاث أو أبثر  

عيّنة أو حواضـــن بداخلةا لوضـــع البطاقات، أو وجود أحرف اير مدضـــلعّة،   بوجود إضـــافات مد

 إضافة إلى أفبار بثيرة أخرى.

 أمر العمل

اشةر مقاسات التصميمات 

 الشاسعة } القوالب {
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الـتـــالـي  والـجـــدول 

المقـاســــــات  يبين  

العالميةّ للتصــاميم  

الـــــدعـــــاســـــيـــــة  

غلفات    .والمد

 

 :  المقاسات العالميّة للورق

عتمدة من طرف     هذه المقاســات مد

ةـــا بـ وجـ مـ بـ ذ  فـــّ نـ وتدـ عـــات،  طـــابـ   الـ

 : مـثـــل  الـمـخـتـلـفـــة  الـمـطـبـوعـــات 

     Brochuresوالمطويات Posterالمدلصقات الإعلانيّة البروت بخنواعةا المختلفة و

 مليمتر   مم (                                     10=  سم(          سم    100= ( م   المتر 

300 dpi بيبسل  300 في البوصه الواحده  =  دقة العمل 

وهنا  مقاسـات ثابتة لافرخ الورق موجودة فى اسـواق الورق عموما واشـةرها هذه المقاسـات 

 : بما يلي 

 اولا : مقاس ال فرخ 100 × 70 سم وأشةر تقسيماته :  

 مقاس نصف الفرخ -

 ( سم 70×  50  

 مقاس ربع الفرخ -

     (سم  35×  50  

 مقاس ثمن الفرخ -

 ( سم 35×  25  

 الفرخمن  16/ 1مقاس  -

 ( سم 17.5× 25  

 

ا للتوّزيع على الفرخ*  . وليس بالضرورة أن تبون التصاميم مدطابقة تماما

 

 الدّقة الارتفاع  العرض النوع

 dpi 300 مم   500 مم   Brochure 300 مطويةّ

 dpi 300 مم   210 مم  95 مطويةّ صغيرة 

 dpi 350 مم  55 مم  Business Card 90 بطاقة عمل 

فبّرة   dpi 350 مم   115 مم  Note book 75 مد

 dpi 300 مم   170 مم   booklet 120 بدتيّب

 الدّقة الارتفاع  العرض النّوع

A4 210   300 مم   297 مم dpi 

A6 105   300 مم   148 مم dpi 

A5 148   300 مم   210 مم dpi 

A3 297   300 مم   420 مم dpi 
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 سم( وأشةر تقسيماته 88×  66ثانيا : مقاس الجاير الببير  
 

  م(س44×  66  مقاس نصف جاير -

      (سم 44×  33  مقاس ربع جاير -

   (سم 22×   33   مقاس ثمن جاير -

( سم 22× 16.5 جاير 16/ 1مقاس    

ــغير   -   82×    57ومقاس الجاير الصـ

ــم( وهبذا فى بل مقاســـات الورق   سـ

ــاحة العمل  ــب مسـ ــيم حسـ يتم التقسـ

 الفنى المطلوب، أو يمبن الطباعة على مساحة الفرخ باملا بدون قص أو تقسيم.

  : نوعةا قاسملطباعة عدة أنواع وهي تختلف بحسب امابينة 

 سم  70× 100مابينة طباعة أوفست 

 سم 70×  50مابينة طباعة أوفست 

 سم  35× 50حيث تطبع حتى قياس 

ولبن هذا لا يعني أنه يجب على المصـم الالتزام 

ــي ــات، ففـ ــذه القياسـ بعض الأحيان   الصارم بةـ

من الجميـل الخروج عن المـخلوف، فـالتصـــــميم  

 إنتاج ما هو جديد.و المعتادالمخلوف وبسر  هو عالم الخروج عن
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هدنا  العديد من البرامج التى يتم بةا تنفيذ الأصـول الطباعية ولعل 

ــبب   ــربة أدوبى . وسـ ادرة عن شـ ــّ ــةرها البرامج الصـ أهمةا وأشـ

لةا وتلبيتةا  Adobe التربيز على برامج   ــاسعة ولتبامد هو بونةا ش

ــيّة من جةة أخرى، montage الغرض من جةة، واعتمادها ببرامج عمل وتربيب   ــاســ أســ

ل اســتلام ملفاّت جاهزة للطّباعة بصــيغ أحد برامج شــربة أدوبى   عظم المطابع تدفضــّ حيث أن مد

تباملة   استخدامةا طبقاا للغرض المطلوب : يمبنوتقدم باقة مد

 Adobe InDesign   أنديزاين أدوبى ـ 1

يستخدم لإعداد الأصول المرببة التى تحتوى على نصوص  

هو  وصــور لبنه يســتورد الصــور لتنســيقةا مع النص. و

صـفحات وترقيمةا  الالنصـوص وإعداد   تنسـياأحد برامج  

ــميم   ــاء تصـ ــور لإنشـ ــوص عليةا مع الصـ وإدراج نصـ

ــميم والتنّســيا  يدعدّ من أشــةر وأهم البرامج    و  طباعى متبامل. للتصّ

وي أدوات ومساحات عمل  تيح  وهو،  الإلبترونية  والمطبوعة    السّريع للمجلّات والجراسد والبتب

  . تدساهم في إنجاز أعمال احترافية خلال أوقات قصيرة نسبيًّا

 

 Adobe Photoshop الفوتوشوبـ 2

يســتخدم لإعداد الأصــول المســتمرة الدرجات مثل الصــور 

ة الصـــــورمن أشـــــةر  وهو   الجـ د  وأقوى برامج معـ ، ويدعـ

و وهو برنامج  ر الأفضــــل على الإطلاق فيما يخصّ الصــــّ

ــصور يقع ضمن فسة برامج التلوين حيث أنه   لمعالجــة ال

صغيرة تسمى    يقوم بتحويل الصورة إلـــى نقـــط مربعـــة

ــلات ــوب    إن تبامل، و الببســ العمل بين برنامجيّ فوتوشــ

الرّسـوم والخطوط الفنّيةّ  معالجة الصـور ووإليسـتريتور باف  لجعل أيّ تصـميم الأفضـل من ناحيّة  

 من جةة والدّقة من جةة أخرى، ويدمبن استخدام أيّ منةما لوحده بحسب نوع العمل

 

 

 برامج التصميم
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 Adobe illustrator  أدوبى اليستريتورـ 3

الأصول الخطية والرسوم التى تحتوى على يستخدم فى إعداد  

يدعد الأفضـل على الإطلاق فيما يخصّ أصـول اير متدرجة. و

عاعي  الرّسـم الأ عالي الدقة،   ( Victor  اتسـم المتجةرشعـ

ه، ويتميّز بـدقّتـه العـاليـة  ويدعـدّ من أهم البرامج في مجـالـ

مةما صــغرت أو ببرت تفاصــيل العمل، وهو يدبامل بشــبل  

متاز باقي برامج شربة    أدوبى .مد

حيحة لأيّ و حيح عمل   البداية الصــــّ والذي يقوم على الإجراءات   لهتبمن في التحّضــــير الصــــّ

 : الأساسية التاّلية

اذا  KYMCنظام الألوان  وتحديد نامج التصّميم الأفضل طبقاا لنوع العمل. اختيار بر ❖

ناسبة طبقاا لنوع التصّميم، واستخدام الدقة  بان التصميم ملون   واختيار المقاسات المد

300  dpi  . 

ةم"  ❖ متعاا  لإالترّتيب "مد ن البداية الصّحيحة والترتيب لأيّ عمل يجعل العمل سلساا ومد

 .   ويزيد من الإنتاجيّة ويدقلل من عدد الأخطاء التي قد تظةربشبل أببر  

 

إن  خاصـةتسـمية العمل بشـبل واضـح بجميع أجزاءه، و  -1

فـــحـــات.  الصـــــــّ تـــعـــدّدت  أو  نـــتـــجـــات  الـــمـــد  تـــنـــوّعـــت 

 اختر مقاسات سليمة واضحة. -2

ناسب واستخدم ألوان إيضاحيّة لذل . الملفاترتبّ  -3 جلدّات بشبل مد  ضمن مجموعات من المد

ناســبة على حواف التصّــمي  -4 ل عادة م  ضــع هوام  مد ســم   1اســتخدام هوام  بمقدار  ويدفضــّ

  .بمسافة أمان 

  .لا تعتمد على ذابرت  أبداا، ووثاّ بل شيء بدقّة وبخاصّة المعلومات الرّسيسيّة -5

 اشةر مقاسات القوالب الطباعية للتصميمات المختلفة.ـ معرفة 6

 ـ معرفة مقاسات الورق وتقسيماته الشاسعة التى تحقا اببر قدر من التوفير فى هال  الورق.7

 ـ معرفة مقاسات المابينة المستخدمة فى الطبع.8

لذا لا تغفل أبدًا عن ما 

 يلي :
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ــا  خمس   ــتوفلل  أوزانهن   Font  ن
ــسـسولةهي   خط البمبيوتر(   عن   المــــ

 : سم  الخط أو عرضه وهي
(  خفيف      Light 1-   

( منتظم       Regular (Normal) 2-   
( نصف عريض      Semibold 3 -   

(  عريض         Bold 4 -    
(  إسود       Black 5 -   

 ملاحظة : 
Italic    ماسل   بتابة ثيـراا فـي بـرامج التـصميم وبقد يرد مصطلح 

 النصوص
أمثلة لأشةر الخطوط العالمية المـستخدمة فـي   الشبل هذا  وفي 

   التصميم معظـم بـرامج
ــن لأأما بالنسبة   ــراا عـــ حرف الطباعة العربية فإنةا لا تختلف بثيـــ

ــات وعاسلات الخطوط الإنجليزية، إلا أن الفرق الوحيد هو أن  قياســ
ا ببعضـةا البعض من أجل تبوين   الأحرف العربية تبون متصـلة داسما

ــةر الخطوط العربية  بلمة ما،   وانحناءاتةا أببـــــــــر، ومـــــــــن أشـ
  ةر فى هذا الشبلظمايالمستخدمة في التصميم 

  قياسات الخط :
قياسـات   تحدد  التصميم  برامج  في  موجودة  مصطلحات  عدة  هنا  

  :الخطـوط وهي
 Leading    : وهي مسافة القياس بين الأسطر 
Kerning  هي المسافة بين حرف ومخر : 

Tracking  :هي المسافة بين الأحرف في البلمة الواحدة. 
 Baseline Shift   :   وبـين الرسيـسي  الـسطر  بين  المسافة  هي 

 Baseline   الأحرف فوق أو تحت الخط الرسيسي
مقياس حجم الحرف فـي   ( Point ) : وأصلةا فـي الغالب بنط

النص. ومن أجل قراءة النصوص يتراوح فـي العادة ما بين قياس  
 .أما العناوين فةي عادة أببر 16  و 10

وهو يدل على نوع الحرف  الخط(، فمثلاا حروف    :  Font  فونت 
        14 بنط مريالهذا النص هي من فونت  

: وهو وحدة قياس عرض أسطر النص المتتالية، عادة ما يبون عمود الجريدة فـي    عمود
سم فـي   4حدود 

 الصحف.  
 

تظةر فيه   بروشور 

 الخطوط العربية  

 خطوط الطباعة
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 برنامج الأنديزاين
( InDesign )   

  

 InDesignالمميزات المختلفة لبرنامج الإنديزاين  
بثيرة و أســـــاســـــيـة ســـــةلـة ويحتوي على أدوات متطورة  هو أحـد برامج الإخراج و –  1

تعديل المطبوعات بجودة طباعى متبامل وتصميم  لالاستخدام لتصميم المجلات والمنشورات  
 عالية.

تخطيط ، ال، و من أهم مميزاتـه الشـــــفـافيـة ، نمـاذج  ةيرثأدوبي إنـديزاين بـه مميزات ب  -  2
ا. تحرير الصوروإنشاء الجداول ووالمحاذاة البصرية للةام  ،   وجعلةا شفافة تماما

هو احد افضــــل ، وبما يحتويه  ةحجم مقارنال، و يعد صــــغير    400MBحوالي  ه  حجم  -  3
ــتندات متعددة الصــــفحات برامج النشــــر المبتبى والرقمى ويمبن  من خلاله انشــــاء  مســ

 .فالانديزاين وجد خصيصا لإدارة الصفحات في البتب و المجلات و الصحف

ت تجـذب   -  4 ة عبر الإنترنـ اعليـ دات تفـ ة ومســـــتنـ ب إلبترونيـ ة وبتـ تصـــــميم مجلات رقميـ
  الأشخاص باستخدام الصوت والفيديو وعروض الشراسح والرسومات المتحربة. 

لعملاء.  للإرسالةا   PDF المستندات بصيغة  تصديردرته على  يتميز برنامج انديزاين بق  -  5
بإمبانية اســـتعراضـــةا من أجةزة الموبايل والأجةزة اللوحية و   PDF حيث تتميز ملفات
يمبن ارافقةـا في البريـد الاليبترونى او حتى عن طريا ارفـاقةـا على وأجةزة البمبيوتر  

 .صفحات المواقع الاليبترونية

6 -   InDesign  ديـه بتير من صـــــيغ ا    الحفظ  لـ ،  indd  ،indl ،indt ،indb:  منةـ

inx  ،idml .  و بإمبانه أيضــا فتح بل ملفات Eps  ،pdf  ،jpg  ،png  ،ai  ،psd     في
 . وتحديث نزولةا على الانديزاينتعديل عليةا بسةولة الوبرامجةا الأصلية 

 . العربية نسخة الشرق الأوسط منةا ، يدعم عدة لغات InDesignبرنامج  - 7

امج    -  8 ة التي    ةالبتير  ها راجع الى مميزاتـذاير مجـاني و هـ  InDesignبرنـ و القويـ

ا. دة   يحتويةـ ه لمـ انـ  الحصـــــول عليـ إمبـ ا =    30و بـ يوم لتجرب عن طريا ضـــــغط هنـ

InDesign 
ــ  9 بفضــل أدوات إعدادات البتابة والتخطيط الاحترافية، يمبن  تصــميم صــفحات متعددة  ـــــ

 الأعمدة تعرض الخطوط الراسعة والرسومات والصور والجداول الغنية.

 .ع يصور بشبل سروالعناصر حول ال إحاطة النص( تلقاسياا   Text WraPأداةـ 10

بسةولة في أي نوع من العناصر للحفاظ على العلامة    هواستبدل  تحديد موضع اللونــــــ  11
 .للطباعة ةاالتجارية وضمان دقة لون

 

  ينفذ صفحة / صفحات ببرنامج الأنديزاينالمخرج الثانى :  

http://js.mamydirect.com/redir/clickGate.php?u=RGm1L5B5&m=1&p=RZ0OgqAE0s&t=ExyEdjJ4&st=&s=Money%20Links&url=https%3A%2F%2Fwww.adobe.com%2Fproducts%2Findesign.html&r=https%3A%2F%2Fwww.hcouchd.com%2F2015%2F06%2Foverview-of-program-InDesign.html
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وللنشر   برنامج هو والمنشورات    المبتبي الصحفى  والمجلات  البتب  ونشر  لتصميم  ويستخدم 

بداية فتح البرنامج، فنجد أن واجةته تتخلف  وفى    .والملصقات وايرها من أشبال المطبوعات

 من خمس مناطا هي : 

https://youtu.be/NMDvti3tEXg?list=PLHoKeP3s3W91cGi6lihJ74W2VfjHJl4sg 

 
 
 

 

 

 

قاسمة منسدلة مستقلة تحتوي على  (  Menu   بالضغط على بل بلمة في شريط القواسم  تفتح 

 وسنورد تل  القواسم لاحقا .  (Sub-menu العديد من الأوامر الفرعية  

 
 

 InDesignالأدوات الرسيسة لبرنامج 

 

   Menu)القواسم   شريط  -1

https://ar.wikipedia.org/wiki/%D8%A8%D8%B1%D9%85%D8%AC%D9%8A%D8%A7%D8%AA_%D8%AA%D8%B7%D8%A8%D9%8A%D9%82%D9%8A%D8%A9
https://ar.wikipedia.org/wiki/%D9%86%D8%B4%D8%B1_%D9%85%D9%83%D8%AA%D8%A8%D9%8A
https://youtu.be/NMDvti3tEXg?list=PLHoKeP3s3W91cGi6lihJ74W2VfjHJl4sg
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ا أسفل شريط القواسم، ويرتبط بشبل بامل بالعنصر الذي يبون محدداا،   يوضّع هذا الشريط تماما

بجب أن تعلم مبان هذا الشريط، لبي تبون  و بداخله تتغير بشبل داسم. والمعلومات التي توجد  

 الأمور سةلة علي  عندما نحتاج للنقر عليه. 

 
 
 

 

ع هذا الشـريط في المنطقة اليسـرى من الشـاشـة. ولتثبيته في مبانه   ، يجب أن الافتراضـييوضّـ

حتى يظةر خط أزرق وعندها    الحواف العليا واليســـرى للوحة البرنامجتقرّبه بشـــبل باف من  

  تحري الســةمين الصــغيرين ســوف تتمبن من    في خلفية  الشــببةوإذا نقرت على    تقوم بإفلاته،

دوات وســحب صــندوق الأ

ــعه في المبان الذي   ووضــ

ــده،   ــالنقر  وتري ب ــا  قمن إذا 

على الســةمين الصــغيرين  

أعــلــى   فــي  الــمــوجــوديــن 

، سـيصـبح  يسـارا الصـندوق

عـن  عـبـــارة  الصـــــنـــدوق 

  عمودين.

اخـتصـــــــارات  نـتـعـلـم  لـبـي 

ــة   ــوحـ لـ ــى  ــلـ عـ الأدوات 

نبـقي   أن  يبـفـي  المـفـــاتيـح، 

مذشـــــر الفـخرة على الأداة 

ا   ــيظةر لنا ثابتا للحظات وس

بالإضـــــافة     اســـــم الأداة 

   Control) – التحبم  شريط القياسات -2
 

 Toolboxـ صندوق الأدوات 3
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( داخل إطار بخرضـــية صـــفراء خفيفة ومن ناحية أخرى توجد  لاختصـــارها على لوحة المفاتيح

 بعض الأدوات فاذا ضغطت عليةا تفتح اطارات لتنويعات على تل  الأداة .رذوس سةام بجوار 

 

 

يحتل شريط المنصات الجزء الأيمن من الشاشة، وظيفة هذا  

يمبن  و  نحتاجةاالشريط هو تخمين وصول سريع للنوافذ التي  

القاسمة هذه  الى  واضافتةا  نحتاجةا  التي  النوافذ   ،  اختيار 

وإذا قمنا بالضغط .    على حاجة بل مستخدم للبرنامج  إعتمادا

نلاحظ أن  على السةمين الصغيرين الموجودين في الأعلى،

 . بل المنصات تمددت وأصبحت تحوي العديد من التفاصيل

الم لةذه  منصة  إضافة  أردت  إلى  نصاتإذا  نذهب    قاسمة ، 

Window    نافذة  ال  منونختار المنصة  من شريط القواسم

وعند الضغط على   Windowستظةر اسفل   التي منبثقة ال

بالضغط  منصة ما ستظةر في وسط سطح المبتب ويمبن 

بقاسمة    ةاتحريبعلى اعلاها والسحب   .  المنصاتوالحاقةا 

ويمبن اظةار وتنسيا المنصات التي نحتاجةا بشبل متبرر  

...    اذا حدث بةا أي تغيير وحفظةا بحيث نعيد استدعاسةا  

 Paletes ت  النوافذ(منطقة المنصا -4
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وبعد اعطاء     Window > Work scape > New work space  هوأمر الحفظ  و

فيتم    OKفندخل اسم هذا التنسيا بةا ونضغط     New Workspaceالأمر تظةر نافذة باسم  

وبالضغط     Workspaceتحت ا   Windowالحفظ بةذا الاسم ويظةر بعد ذل  في قاسمة  

 عليه يفتح لنا القاسمة التي نسقناها من قبل. 

 

 

 

إن تحديد هذه المساحة أمر بغاية السةولة، فةي ببساطة بل ما تبقى من واجةة البرنامج، في  

ثم شريط شببي يظةر عليه    Controlوأسفله شريط    Menuشريط  القواسم    الأعلى، يوجد  

د  على الشاشةعلى هيسة  اسم الملف وبالقرب من الاسم تماماا درجة التببير   وفي  ،(Tab لسانا

الشببي هذا ستظةر بل الصفحات المفتوحة ويتغير لون شببة اللسان التي نعمل عليه  الشريط  

 هو الأفتح بينةم . 

نجمة صغيرة تسبا الاسم، هذا يعني    ظةرت  ويمبن  التنقل بسةم الفخرة بين تل  الصفحات فإذا

  شاشةوسط الوفي    .في تل  الصفحة أو الملف  أن هنال  بعض التعديلات التي لم يتم حفظةا بعد

الملف اللون يمثل  ، أما المساحة الموجودة  اعمل عليةنالذي     الصفحة(    نرى مستطيلاا أسود 

   منه عند طبع المستند. لا يطبع شيء  حول هذا المستطيل  الصفحة( ف

 

 منطقة العملـ 5
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 Show Rulers إظةار المساطر

 إن لم تبن ظاهرة اذهب إلى ويسار منطقة العمل    وفي توجد المساطر في أعلى

Show Rulers View > 

ولسحب مسطرة تقوم بالوقوف بالماوس على احدى المساطر في الأعلى أو اليسار ثم تسحب  

 الى المبان الذي ترابه مع الضغط ثم تفلت الضغط حينما تنتةي 
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 File  > New >  documentبعد فتح البرنامج  ولفتح مستند جديد نذهب الى الأمر  

تفتح اللوحــة المبينــة والتي تحتوى معلومــات نقوم بــادخــالةــا عن حجم الملف والطي وعــدد 

ويمبن اختياريا الاحتفاظ بةذا التوضـــيب في مبان ما بعد اعطاسه اســـم بخســـاس مثلا   الصـــفحات ...ال،  

 https://youtu.be/7ENvegyboig  (بحيث يتم استدعاسه عند الحاجة    A4لتوضيب صفحة 

هذه الأوامر هي افتراضات تتغير حسب متطلبات العمل لبل مطبوع ويمبن  تغييرها بلما تغير  

 لبننا سنشرح محتويات الجدول :  المطبوع

 

 

 

 انشاء مستند جديد -6

https://youtu.be/7ENvegyboig
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تشـــاء والغرض من حفظ التوضـــيب ويمبن  تغيير الاســـم بيفما  Default مبتوب افتراضـــي  

ــم ذل  الحجم ويبون بةا بل  ــميتةا باســ اعداد قاسمة تحتفظ بةا لدي  لبل حجم مثلا ويمبن  تســ

 .المعلومات ونحب ان ننبه ان التوضيب هو جملة المعلومات عن الملف وليس الملف ذاته

 Facing pageالصفحات المتقابلة 

ــير داخل   ــفحة  اختيار هذا الأمر بالتخشـ ــفحات متجاورة بمعنى صـ المربع المجاور له يختي بالصـ

سـبريد أو دوبل بيج(   يمين وصـفحة يسـار لبل صـفحتين اي يعمل من بل صـفحتين ما يسـمى  

Spread or Double Page      واهمال هذا الأمر يجعل بل صــفحة مســتقلة في توضــيب

 رأسي تتابعي.

 Primary or Master text frameبتلة النص الابتداسية أو الرسيسية 

التخشـير داخل المربع المجاور لةذا الأمر ينشيء  بتلة نص( على حدود الةام  و بتلة النص( 

ــنقوم بالبتابة داخله وقد نحتاج هذا الأمر اذا بان المطبوع بتاب ومبان  ــتطيل الذي سـ اي المسـ

 بتلة النص ثابت في جميع الصفحات فنذشر على المربع المجاور لةذا الأمر

 Paper sizeأو الورق م الصفحة حج

على رأس   التخشــــير

الســـــةم في اقصـــــى 

ذا الأمر   يمين مربع هـ

ــابقـة  في اللوحـة الســـ

قـــاسـمـــة   لـــ   يــفــتــح 

ــدلة بةا عدد من  منسـ

ــارات   ــيــــ ــتــــ الاخــــ

الافتراضـية لصـفحات 

 من احجام مختلفة.
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وعنـد اختيـار حجم معين من تلـ  القـاسمـة يقوم الحـاســـــوب ببتـابـة الحجم الخـاص بةـا تلقـاسيـا في  

أن تقوم بذل  بنفسـ  ويبقى ل  أن تحدد الحجم بنفسـ    خانتي العرض والطول دون الحاجة الى

ــة التي لا يرتبط حجمةــا بــالأحجــام التقليــديــة. ولةــذا الحجم الخــاص  في الأعمــال الخــاصــــ

ار انتي     Custumتختـ ــ  في خـ ادخـال العرض والطول بنفســـ ة ثم تقوم بـ اسمـ ة تلـ  القـ ايـ من نةـ

  Height و  Widthالعرض والطول 

     Orientation الاتجاه

 

الموجودة في لوحة الأمر انشــاء مســتند جديد الســابقة  يبون تلقاسي   التخشــير على تل  الأيقونة

ــابقـة بمـا يبون تلقـاسيـا وفا قيم الطول  عنـد اختيـار حجم مســـــبا الادخـال بمـا في الخطوة الســـ

والعرض التي تقوم بـادخـالةـا بنفســـــ  وربمـا تتـدخـل لتحويـل العرض الى طول بـالتـخشـــــير على 

 احداهما.

 ملاحظة هامة :  

ولبن يمبن اضـــافة وحدات القياس  Pica  وحدات القياس الافتراضـــية للبرنامج هي البايبا  

التي ترابةا بجوار الحجم في الطول أو العرض ببتابة اختصار تل  الوحدات بجوار رقم القياس  

ويقوم الحاسـوب     inو للبوصـة نضـيف    mmوللملليمتر نضـيف    cmفللسـنتيمتر نضـيف  

تحـديـد وحـدات القيـاس من مع العلم انـه يمبننـا    تلقـاسيـا بتحويـل الأبعـاد المـدخلـة الى تلـ  الوحـدات.

 التفضيلات العمومية للبرنامج والتي سنشرحةا في مبان مخر.

  More Option( Bleed and Slug) إختيارات أبثر

ــمن أمرين أولةما التعري      ــاء ملف جديد ليتض ــابا انش   Bleedيقوم بزيادة حجم الأمر الس

وهي مسـاحة اضـافية تضـاف للمسـتند وتقص لاحقا حتى لا تحدث عيوب في المطبوع خاصـة اذا 

 صورة.بان يحتوي على أرضية تصل الى حافته أو 

عـا يقوم الطـابع بـازالتـه من والأمر الثـاني هو الملاحظـات التي يرســـــلةـا المصـــــمم للمطبعـة وطب

ــ    Slugالمطبوع قبل الطبع وهي ما تعرف باسم   ،   أنه يطبع ثم يقص  Bleedوالفارق بين ال

 عبيظة أو رسالة للطحيعتبر ملا هأنه لا يطبع لأنه ليس جزء من الملف لبن  Slugأما الـ 
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 ملاحظة هامة :  

 Fewer)بعد الضغط على اختيارات ابثر وفتح الأمر يتحول الأمر الى اختيارات أقل  

Option )  لإعادة تصغير لوحة الأمر قبل الحفظ والاالاق 
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 ( يحرر   Editقاسمة  -

   تخطيط ( Layoutقاسمة  -
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 ( نماذج   Typeقاسمة  -
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 ( وظاسف   Objectقاسمة  -



 

 

 

 صف أول     –  طالبدليل ال     ـــــــــــــــــــــــــــــــــــــــــــــــــ     ين نديزاالطباعية بالإ الأصول  إعداد

30 

 

 

30 

 فني طباعة وتغليف 

 

 

 
 ( جداول   Tableقاسمة  -
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 ( عرض   Viewقاسمة  -
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   النوافذ ( Windowقاسمة  -
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يمبن إظةار المنصات التي نحتاجةا في العمل من  

 .    Windowقاسمة النوافذ 

ــتفيد من   بما يمبن الاحتفاظ بترتيب تل  المنصــات بحيث نس           

الأمر   بعـمـــل  القـــادمـــة  للـمـرات  ترتيـبـةـــا   Windows > workspace> newوقـــت 

workspace 

نافذة لحفظ ذل  الترتيب فنقوم بتســميتةا بالاســم الذي نراب به والذي ســيبون   وبعد ذل  تفتح

بحيث نعود اليه بلما زال ترتيب تل  المنصات    Workspaceمتاحا في قاسمة  ويندوز  تحت  

 أو أالقت احداها

 

 

 

 

 

 

 

 

 

 إظةار المنصات التي نحتاجةا-
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ينبغي التفبير في أهم الخطوات الا وهو تنسـيا    قبل الاسـترسـال في عرض أوامر ونوافذ أخرى

أحجام وتنســـيقات خطوط المســـتند وحفظ تل  التنســـيقات تمةيدا لاســـتدعاسةا وتطبيقةا بمجرد  

ــيقات الخطوط ــغطة ماوس واحدة وتنســ ــمل نوع الخط  Characterتعرف بالأمر   ضــ  وتشــ

في تببيره أو تصغيره    وحجمه ولغته وداخل اللوحة يمبن التحبم في المسافة بين حروفه وبذل 

 أفقيا أو رأسيا وسوف نضيف لون البتابة من بالتة الألوان 
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العنوان الفرعية نحدد هذا  الرسيسية أو  العناوين   وبمجرد الانتةاء من تنسيا الخط للمتن أو 

من      Character styleبنفس الطريقة المذبورة في الصورة السابقة ونقوم بفتح الأمر   

وتختار   اللوحة  تل   يمين  أعلى  الصغير  السةم  على  وتضغط  اليسرى   Newالمنصة 

Character style  فيقوم الحاسوب بتسجيل     ثم تحدد المزيد من المعلومات التي سيطلبةا

 سم لةذا التنسيا جميع القيم ويطالب  فقط بوضع ا
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 Character styleوسيحتفظ انديزاين بةذا التنسيا بالاسم الذي حفظته به ويظةر في نافذة  

 Paragraph    &Paragraph styleفي المرات القادم

وفيةا نحدد   Paragraphبما يقتضــــي التنســــيا القيام بضــــبط الفقرات البتابية في الأمر  

مســافات الســطور واذا بانت الفقرة ســتبدأ بفراغ أو بحرف بحجم ببير وبذل  محاذاة الفقرة اذا 

أو لليسـار  Center أو للوسـط Right و لليمين      Justify بانت البتابة سـتبون منتظمة  

Left  ار بما  بما نحدد اذا بان مطلوب أن تميز تل  الفقرة بالتصـغير الأفقي من اليمين أو اليسـ

 نحدد اتجاه الفقرة ومسافة الحروف التقريبية
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بخطوات مشابةة للسابقة حيث     Paragraph styleوبعد ذل  نقوم باعداد مواصفات الفقرة  

ونحدد بل المعلومات ونعطي     New Paragraph styleنفتح لوحتا من المنصات ونضغط  

للمرات القادمة      Paragraph styleللتنسيا اسما فيحتفظ الانديزاين بةذا التنسيا في لوحة  

 بالاسم الذي حفظته. 

 Paragraphالجدير بالذبرلتنسيا الفقرة بما فيةا نوع الخط في المرة الثانية نضغط فقط  

style     وليسCharacter style      
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مــــن الأوامــــر الةامــــة خصوصــــا لتصــــميمات 

ــذا الأمــر الــذي  ــعارات والســيل  ســبرين ه الش

يـــتحبم فـــي مواصـــفات تفريـــغ او عـــدم تفريـــغ 

 . بعض الألوان عند الفصل

 

  Attribute أمر
   خصاسص مميزة (

- 
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الأعمدة  و التحبم في عدد لتعديل حجم  الةوام   

 ر نذهب للأموالمسافة بينةم  ف 

Layout> Margins and column     فتظةر

 النافذة التالية

 
 
 
 
 
 
 
 

 الةوام  والأعمدة-
Margins and column 

- 
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  ســـــنـخخـذ مثـالا عمليـا لتنفيـذ مطبوعـة 

ومن   صـفحات صـفحة أو عدةتتبون من 

ــنتعلم بيفية تخطيط  خلال هذه العملية سـ

 .  الصفحة بناء على النموذج  المابيت( المرفا والضوابط التي يطلبةا العميل

 

 فى الصفحاتمعرفة طريقة توزيع الصور والنصوص  لقوالب مساعدة نماذج ل

الرســــم يوضــــح المابيت والمادة هذا  

  والصورة للصفحة الأولى

 A4مقاس التنفيذ 

من جميع الاتجــاهــات   1.5الةوام   

 للداخل

وان    ويـن    KYMCالألـ لـ تـ بـ زم  تـ لـ ويـ

 العناوين وخلافه حسب المابيت

 التنفيذ

يفتح برنـامج الانـديزاين الموجود في  

 مجلد التطبيقات 

اتبع المســـار ا تي  من   في الويندوز

 اليسار لليمين(

This Pc > Local disc (C) > 

Program files (x86) > 

Adobe > 

 Adobe Indesign CS6 > In 

design 

 / عدة صفحات صفحة خطوات تنفيذ-
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 إضغط  بزر الماوس الأيسر ضغطتتين سريعتين على أيقونة إنديزاين سيفتح البرنامج

ــريع    ملاحظة : ــةولة  لتسـ ــريط عملية الفتح  سـ ــافة ايقونة البرنامج الى شـ يتم اضـ

اســـتعمال المســـار الطويل الســـابا  الأدوات الأســـفل للضـــغط عليةا مباشـــرة دون 

 اختصارا للوقت والجةد

 

ويتم ذلـ  بتتي ... بعـد فتح البرنـامج ســـــنجـد أن تلـ  الأيقونـة قـد أخـذت مبـانـا في 

شـريط ا دوات تلقاسيا فاذا أالقنا البرنامج تختفي لذل  فالمطلوب تثبيتةا في شـريط 

أدوات البمبيوترالأسـفل ولعمل ذل  نضـغط ضـغطة خفيفة على تل  الأيقونة وهي في 

الماوس الأيمن فتفتح قاسمة صغيرة فوقةا  وذل  بزر  (Taskbar)شريط الأدوات 

ولإالاق القاسمة يتم الضـــغط في أي مبان     (Pin to taskbar )فنختار منةا  

ــة ....  وفي المرات القادمة نفتح البرنامج من هذه الايقونة التي  ــاش فارغ على الش

 ستبون في شريط البرامج اسفل سطح مبتب البمبيوتر.
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بعــد الضـــــغط على ايقونــة الانــديزاين يفتح البرنــامج ونقوم  

فتفتح نافذة انشـاء مسـتند جديد   File > Newباصـدار الأمر

التي سبا شرحةا وفي تل  النافذة سوف نقوم بإدخال البيانات 

من    cm 1.5والةوام    A4المطلوبة من حيث حجم الصـــفحة  

ليمين لليسـار..بما يمبن تحديد هام   وتفتح الصـفحات من ا  4جميع الجوانب وعدد الصـفحات 

  ملم من ثلاثة اتجاهات اعلى واسفل وللخارج. 3للقص بمسافة 

 

تفتح الصــــفحة ويبون فقط مبان الةوام  ظاهرا عليةا على هيسة اطار باللون الأزرق وهو لا 

 يطبع 

مجلدات فرعية بداخلةا ينبغي لتنظيم العمل فتح مجلد لبل عملية ونقوم بانشاء    ملاحظة هامة : 

واحد للصفحات الانديزاين وواحد للصور وواحد للمادة وفي المطابع والجراسد الببيرة ومع عزل  

التخصصات يتم تنظيم العمل ووضع تل  المجلدات على السيرفر حيث يقوم قسم الجمع بحفظ  

مخر، وقد    المواد في مبان محدد ويقوم قسم فصل الالوان بحفظ الصور بعد ضبطةا في مبان

 استحدثت طرق وبرامج للتنسيا بين تل  الأقسام لتسةل جلب تل  المواد والصور لتسةيل العمل 

 فتح صفحة جديدة-
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 رسم بتل التصميم-

 بتلة العنوان الرسيسي  -2
 نفتح بتلة مادة للعنوان 

  نختار أداة إدخال البتابة  •

زر  • والاستمرار على  الضغط  مع 
الماوس  نحر   الأيسر(  الماوس 

ولأسفل وعند انتةاء الرسم  يسارا  
 نفلت الماوس 

 

 بتلة الصورة   -3
 نفتح بتلة للصورة 

    نختار أداة إدخال الصور  •
مع الضغط والاستمرار على زر   •

الماوس  نحر   الأيسر(  الماوس 

يسارا ولأسفل وعند انتةاء الرسم  

 نفلت الماوس 

 رسم بتلة المادة المقسمة  -1
بالعرض  للمادة  واحدة  بتلة  نفتح 

 البلي 
 نختار أداة إدخال المادة  -1
زر   -2 والاستمرار على  الضغط  مع 

نحر    الأيسر(  الماوس  الماوس 
الرسم   انتةاء  وعند  ولأسفل  يسارا 

 نفلت الماوس 
بعد انتةاء رسم البتلة نختار السةم   -3

اعلى يسار مستطيل الأدوات ونحدد 
عليةا بالضغط  البتلة  الزر  ب  تل  

 لماوس لالأيسر 
البتلة     باستخدام -4 تقسيم  اداة 

لوحة    أعلى  الموجودة 
قليلا   لليمين  عدد والبونترول  نبتب 

  أعمدة هنا (   3  المطلوب  الأعمدة  
 من البيبورد  enter مفتاح ونضغط
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 تنزيل المادة وتبنيطةا والصور وانةاء الصفحة الأولى-

 تنزيل العنوان-1

 باستخدام اداة البتابة  •
نممحممممدد الممعممنمموان بممتمممممريممر 
الماوس فوقه مع اسمممتمرار 

الزر الأيسممممر   ىالضممممغط عل
ثم نفلته بعد التظليل ونقوم 

 ببتابة الأمر  

•Control X  لقصممممممممه ثم
نمممذهمممب لبتلمممة العنوان في 
الصمممممفحة ونضمممممغط داخلةا 

باستخدام أداة ادخال البتابة    

لمملصمممممممما الممعممنمموان   
  Control Vبمممممالأممممممر 

وفيما بعد يجري اختيار خط 
 Characterمن منصممممة 

واعطاسه الحجم المناسمممممممب 
وتممطممبمما نممفممس الممخممطمموات 

 للعنوان الأصغر.
 

ويتم تحديد البتلة  المناسب .
ووضع علامة ادخال البتابة 
داخلةا تمةيدا لتقسيمةا الى عدد 
الأعمدة المطلوبة باستخدام أداة 

   تقسيم البتلة
التحبم اعلى الموجودة في شريط 
 . الصفحة الى اليمين

 

 تنزيل الصورة-3
لجلب الصورة يتم تحديد الاطار 
الخاص بةا بالضغط عليه 

 بالماوس مع اختيار السةم 
  وبعد ذل  يتم اختيار الأمر

File > Place       أو إختصاره
Control D  ثم نبحث عن

الصورة  في مبان حفظةا 
ونذشر عليةا بالماوس ثم 

 OKنضغط 

 

   تنزيل المادة-2

بعممد قص العنوان تتبقى المممادة •
فيتم نقلةممما لبتلمممة الممممادة على 

 الصفحة با تي

في   توضممممع أداة البتابة   •
ونقوم ببتممممابممممة الأمر  البتلممممة

   Control A  لتحممممديممممد بممممل
 Controlالنص ومن بعد ذل  

X   لقصمممه ثم نذهب لبتلة المادة
في الصممممممفحة ونضممممممغط داخلةا 
بة   تا خدام أداة ادخال الب باسمممممممت

ثممممم نممممبممممتممممب الأمممممر    
Control V  للصممممممما المممادة

تحمممديمممد بلي وفيمممما بعمممد يجري 
 Control Aثممممانممي لمملمممممممادة   

اخممتمميممممار خممط مممن مممنصممممممممممة و
Character واعطاسه الحجم 
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 رسم الخط السفلي -4

لعمل الخط الأســــفل نختار أداة   

ونضــــغط ضــــغطة   القلم  

واحدة في بداية الخط ثم ضـغطة  

ثــانيــة في نةــايتــه مع ضـــــغط 

ــاح   مفت الاصـــــبع على  وتعليا 

في البيبورد  (  Shift   العــالي  

وبعد ذل  يتم اختيار نوع وسم   

بما     Strokeمن منصـة   طالخ

نصـــــــة   مـ مـن  نـــه  ويـ لـ تـ ن  بـ مـ يـ

Swatches . 

 

الصـــــفحـات النموذجيـة   ــد بـ يقصـــ

الــعـــام    Generalالــتــخــطــيــط 

Layout     ــه تطبيق يمبن  ــذي  ال

ة من  ت على مجموعـ ابـ ل ثـ بشـــــبـ

ام   خرقـ د بـ الصـــــفحـات في مســـــتنـ

ــفحات وأحيانا بعض البتابات  الصـ

تطـبـيا  .  الأخرى انـــديزاين  ويتـيـح 

نـمـوذجـيـــات   الـ لـــ   تـ فـي  تـحـبـم  والـ

ــاصـــــرهــا في   وتجــاوز بعض عن

منةا   أمابن معينة واضــافة الجديد

 طبقا للحاجة.

 الصفحات النموذجية -
 Master Pages 

- 
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تفتح   الصغير  السةم  رأس  على  بالضغط 

 التفضيلات المبينة حيث يمبن من خلالةا اضافة  

 

 

صفحات للمستند أو اضافة صفحات نموذجية او تجاوز عناصر الصفحات النموذجية أو عمل   

المجلات واجراء العديد من العمليات الةامة اثناء  تفضيلات خاصة للترقيم في أجزاء البتب أو  

 تنفيذ مستند على انديزاين 

 

 

تفضيلات الصفحات النموذجية   
Master Pages Options 
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نذهب الى      Linksللوصول الى بالتة أو منصة الـ  

الأمر    Window > Linksالمسار   نضغط  أو 

 Shift + Ctrl + Dالمختصر 

المراد إدخالةا هي المواد     Linksالروابط أو الـــــ 

التي نجلبةا لتبملة الصـفحة أو المسـتند بالمادة المبتوبة  وتتربب من الفونتات(  والصـفحة   إلى

ــياء أخرى ــومات أو أي اشــ ــور أو الرســ واللينبات هنا تختلف عن اللينبات في الويب   .والصــ

 .  Hyperlinkالمسماة 

ــتندة وان لم  ويحتاج الانديزاين داسما الى تحديث تل  الروابط وأن تبون محدثة قبل طباعة المس

تبن بذل  فيقوم الانديزاين بتحذير  عن طريا وضـع علامة اسـتفةام بجانب تل  الصـورة  في  

طالبا من  تحديث الصورة أي اعادة تعيين مبانةا في البمبيوتر وعندما يحدث    Linksبالتة الـ

فإن الانديزاين يتعرف عليةا بمجرد  ذل  وبفرض أن بل الصـــور تبون موجودة في مبان واحد  

والحـالـة الثـانيـة لفقـد الارتبـاط ان تبون الصـــــورة قـد تم تعـديلةـا  ويحـدثةـا تلقـاسيـا إحـدهـاتحـديـث 

خارج الانديزاين بعد جلبةا اليه ... في هذه الحالة يضـع الانديزاين سـةما أصـفر بجوارها طالبا 

 .تحديثالذهاب الى مبانةا مرة اخرى واختيارها ثم اعادة ال

بممممالتممممة الروابط او منصممممممممممة -1
 Linkالروابط 

2- 
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لـــذل  ننصـــح مســـتخدم الانـــديزاين بـــخن 

ــل  ــد لب ــز مجل ــغليجة ــد ش ــة( جدي   عملي

قبــل البــدء ويحتــوي هــذا المجلــد علــى 

ــومات  ــور والرســــــ ــدات للصــــــ مجلــــــ

 والفونتات ان أمبن بالمثال التالي

وبةــــذا التنظــــيم ســــيبون ســــةل علــــى 

البمبيــوتر أو المســـتخدم ســرعة معرفـــة 

ــروابط ــه . و وتحــديث ال ــذبر أن الجــدير بال

عنــد انتةــاء العمــل فــإن هنــا  أمــر يقــوم 

ــمى  ــديزاين ويس ــتند الان ــافة لمس ــور بالاض ــواد والص ــع الم ــيم وتجمي ــة  أي تنظ ــذه العملي بة

ــذا الأمــر  ــار  Packageه أو عــن طريــا   File > packageويــختي عبــر المس

  ( Alt+ Shift + Ctrl + P ) الأمر المختصر 

ــل اي  ــام : لا تتجاه ــبلة ه ــل المش ــاول ح ــام وح ــدأ ع ــذير تصــادفةا بمب رســالة تح

 داسما.
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عند إعادة فتح مســـتند فإن الإنديزاين يراجع  

عند رســـالة تحذير  ويعطي    Linksالروابط  

فقــد أو تعــديــل أحــد تلــ  الروابط إذا بــانــت  

 صورة أو رسم ويعرض علي  فونتات بديلة  

Substituted Fonts   فى حــالــة عــدم

بـنـــت  وإذا  يـوتـر   بـ مـ بـ الـ فـى  الـفـونـــت  وجـود 

د  ا وأعـ ديلات ارفضـــــةـ لاتراـب فى تلـ  التعـ

تحديث الروابط والفونتات بنفســــ  من خلال  

الـروابـط مـربـع  تـحـــديـــث  عـلـى  ــغـط   الضـــ

Update Links  بنفس رســالة التحذير )

واعادة تعيين الصــور والرســومات المفقودة  

 او المعدلة أو الضغط على   إيجاد الفونتات  

( Find Fonts      ــالــة تحــذير  في رســــ

  )  Missing Fontsالفونتـات المفقودة  (

از  ات الجةـ ة فونتـ اسمـ ات من قـ د الفونتـ ديـ وتحـ

فـإن لم يبن موجودا فيجـب االاق المســـــتنـد 

دون تغيير واحضارالفونت ونسخه أو تحميله  

 Windows)في مجلد الفونتات بالسـيسـتم  

System – Fonts Folder)    ثم فتح

   المســـــتنـد ثـانيـة واعـادة تحـديـث هـذا الفونـت.

ــاسـل التحـذير تلـ  اير ثـ ابتـة ويلاحظ أن رســـ

وســـــوف يبون موضـــــحـا عليةـا المفقود أو 

ــختي   ت ــد  ق المفقود. بمــا  ــت  أو الفون المعــدل 

رســــالة تحذير خاصــــة بالصــــور ورســــالة  

 تحذيرأخرى خاصة بالفونتات
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ترقيم   لإضافة 

 اتوماتيبي للصفحات ينبغي عمل عدة خطوات بالتالي

 نفتح مستند جديد  •

 ات ونحدد الصفحة النموذجية المستعملة حنذهب الى نافذه الصف •

 نضغط ضغطتين متتاليتين على تل  الصفحة النموذجية  •

 البتابة ونختارها من مستطيل الأدواتنذهب الى أداة  •

نريده   • الذي  المبان  الى  الصفحة ونحربه  لرقم  بتابة  اطار  البتابة نصنع  اداة  بواسطة 

 ونتر  أداة البتابة داخله 

 نطبا المسار التالي   •

• Type > Insert special Character > Markers > Current page Number 

 alt + shift + ctrl + Nأو نبتب الأمر المختصر               •

 نقوم بتبنيط الرقم حسب التصميم  •

 

قد تحول الى رقم وبلما أضفنا صفحة أخذت     Aعند الانتقال الى الصفحات سنرى ان حرف الـ  

 الرقم المسلسل الصحيح اتومايبيا. 

 إضافة ترقيم تسلسلي ملي للصفحات في مستند -

Adding Auto number To pages in Adobe Indesign 
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نحددها بالضـــــغط  لتحري  صـــــفحة
ــفحات ثم نذهب   عليةا في بالتة الصــ

 Layout> Pages > Move Pagesللأمر
 

من خلال الضــغط على المثلث اقصــى يمين بالتة الصــفحات الوصــول لنفس الأمرويمبن أيضــا 

Pages  وبعد تحديد المبان الجديد تنتقل الصـفحة  سـوف يفتح مربع الحوار التالي  بعد فتحةا

 اليه

  

 

 

 

 

 حري ، مضاعفة، وحذف الصفحاتت
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بوضـع لونين عليةا أعلى الرقم وإعطيت أمر الانتقال    1قمنا بتمييز صـفحة  في الرسـمة السـابقة 
 وظةر اللونين هنا  6فجاست في موقع ص  7الى ما قبل ص 
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ــح  ــمة التالية توضـ الرسـ

بعض العمليات المشـابةة  

لتحري  الصـــــفحـات مثل  

ــ،  ــفحات و نسـ إدخل صـ

لـــة   قـــابـ تـ مـ حـــات  ــفـ صـــ

(Spread)    أو حـذفةم

الأوامر في   ــ   تل وتظةر 

ث   ل المثلـ اسمـة أســـــفـ القـ

الصغير الموضح بالداسرة 

ــتـــة   بـــال فــي  الــحــمــراء 

 الصفحات

 التحري  يدويا في بالتة الصفحات
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 بالتة الصــــفحاتحجم صــــفحة ، حدد الصــــفحة في    غييرلت

Page  المـاوس ا بـ الضـــــغط عليةـ اضـــــغط على أحـد ، ثم  بـ

  .والموضــحتين فى الرســمه التالية      الأداتين  

ســتظةر قاسمة صــغيرة بةا عدد من القياســات الثابتة عالمياا وفى  

لإدخال   وبالضـــغط عليه يفتح نافذة اخرى  Custom  مقاس خاص  نةاية تل  القياســـات خيار

 المقاس المطلوب.

 أحجام متعددة في نفس المستند 

A  صفحة مجلة  .B  صفحة عريضة .C صفحة مزودة بعمود رسيسي . 
 

 إنشاء أحجام مختلفة

 للصفحات داخل المستند



 

 

 

 صف أول     –  طالبدليل ال     ـــــــــــــــــــــــــــــــــــــــــــــــــ     ين نديزاالطباعية بالإ الأصول  إعداد

62 

 

 

62 

 فني طباعة وتغليف 
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   Menuأن أوردنا قاسمة الجدول اثناء استعراض القواسم   سبا

 

القاسمة السابقة لن يعمل هبذا ولبي  لبن ينبغي الانتباه أن أمر ادخال جدول وهو أول أمر في  

 ( T )  يعمل هذا الأمر ينبغي أولا رسم بتلة مادة باستخدام أداة البتابة

 Insert Tableوحينةا سيعمل أمر 

Table > Insert Table  

 ( Alt+ Shift+ Crtl+ T ) أو الأمر المختصر 

إنشاء الجداول في 
 انديزاين
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 بعدها سيفتح مستطيل عمل الجدول

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   - :  سيظةر الجدول بالشبل التالي
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أو   headerويمبن تحديدعدد الصــفوف الثابتة  اذا بان هنا  صــف أو صــفوف ثابتة علوية  

ويمبن في بل وقت العودة بعد الرســــم لعمل اي   Footerصــــف  أو صــــفوف ثابتة ســــفلية  

 تعديلات بإضافة أو حذف صفوف أو أعمدة ببل سةولة

 Table >Table optionsولعمل تل  التعديلات نذهب الى الأمر  

لبن أيضا حتى يعمل هذا الأمر فينبغي تظليل بتلة النص أولا بالضغط داخل أول خلية والسحب  

 لأسفل 

 

 و بمجرد تظليل بتلة الجدول تنشط أوامر شريط البنترول بخوامر التحبم في الجدول
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    أو خلية قاسم على تحديدها أولا وبما بالشرح تحدد  أداة البتابة(تعد القاعدة لتغيير أي بيان  

من صندوق الأدوات أقصى يسار الصفحة أولا ثم نقف أمام الصف الذي نريد تحديده أو  

( وبالضغط على السةم يتم تحديد المتجه له    العمود حتى تتحول تل  الأداة لسةم صغير   

نين بالضغط بخداة البتابة داخلةم مع التحري  من الأولى  السةم ويمبن تحديد خلية واحدة أو اث

 للثانية 
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يلاحظ ان الأوامر الموجودة في بنترول بانل الجداول موجودة أيضا ومجمعة في أمر واحد في  

 Windows > type & tables > Tablesمبان مخر وللوصول اليه  

 Shift + F9أو الأمر المختصر 
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https://www.youtube.com/watch?v=5Ku7CdmNaE0 

 

 

 

https://www.youtube.com/watch?v=5Ku7CdmNaE0
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   ذيل الجدول (    Footerوبنفس الطريقة يمبن تحويل صف الى فوتر 
Table > Convert Row > To Footer  

 سنبمل في صفحة لاحقة والمعروف  أيضا أن الفوتر أو ذيل الجدول سيتبرر لو  
 ملاحظة هامة : 

 ESCفيةا ثم إضغط مفتاح   (T)لتحديد خلية بسةولة أدخل علامة البتابة 
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بما  

صف وقد قمنا بتحري  الخطوط مع    22أعمدة و  5أنشخنا الجدول السابا أنشخنا تل  الفاتورة من  

الضغط على شيفت وقمنا بضبط أرتفاعات الخلايا وبذل  الةيدر والفوتر وقمنا بتحويل خطوط  

فواصل الصفوف الى نقاط صغيرة لتيسير البتابة اليدوية وقمنا بتقسيم خليتين في الةيدرن وفي  

 .  النةاية أضفنا البتابات
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يمتاز إن ديزاين بتوضـــيح وجود أخطاء بالملف التي تظةر  

يسار الشريط السفلي  لنافذة المستند مسبوقة بداسرة حمراء  

 للتنبيه وهذه الميزة تذدي لمعالجة الأخطاء قبل الطباعة
 

ــةـــار ــبـــاعـــة    ولإظ ــط ال ــبـــل  ق ــر  أم

(Preflight)     ز نذهب لقاسمة ويندو 

 

Windows > output > preflight  

 /S4aPFWXiyo-https://youtu.be  للمزيد تابع الفيديو

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  المراجعة(قبل الطباعة 

Preflight 

https://youtu.be/-S4aPFWXiyo
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 File > Exportالأمر 

 

التصدير اليةا عند  يوضح وجود أبثر من فورمة واحدة يمبن لإنديزاين    exportالأمر 

 Adobe PDFومن أهم تل  الفورمات التصدير الى  الضغط على رأس المثلث المقلوب 
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امخرجات التعلم لةذه الوحدة.  فبر في أداس  الخاص أثناء عمليات التعلم والتقييم       لقد أبملت مذخرا

، حدد نقاط القوة والضعف في هذه العمليات    باستخدام الجزءالأول من ورقة العمل المقدمة 

.  ماذا وجدت من التحديات، وما بان السةل بالنسبة ل ،وماذا ستفعل    على سبيل المثال   -

 ؟  بشبل مختلف إذا بان لدي  الفرصة للقيام بذل  مرة أخرى

، استخدم الجزء الثاني من ورقة العمل، للتخطيط    ب بمجرد تحديد نقاط القوة والضعف الخاصة  

على سبيل المثال.   "أنا   -لبيفية تحسين أداس  فيما يتعلا بنقاط الضعف التي لاحظتةا  

بحاجة إلى الاستماع بعناية أبثر إلى ما يقوله ا خرون.  يجب أن أبتب الأشياء قبل أن  

ية حتى أتمبن من التواصل بشبل أفضل  "أنا بحاجة إلى تحسين لغتي الإنجليز   - أنسىاها "  

مع العملاء. يجب أن أهدف إلى تعلم بلمة واحدة جديدة على الأقل في اليوم، وممارسة  

 التحدث بةا مع صديا.' 

علَم .    عند الانتةاء من ورقة العمل الخاصة ب ، يرجى مناقشة التقييم والتخطيط مع مد

 

 

 

 

 

 

 

 

 

 

 

 المهمة تقرير التقييم الذاتي وخطة التنمية
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 دراسة الاصول الطباعية ومنتجتها 1-1 أمر العمل 

 ... مراحل الطباعة.. من التجهيزات الفنية حتى التجليد - تحقيقات   

 .الأسس الفنية لتجهيزات طباعة الاوفست ذات التغذية بالفرخ  

 أدوبي إنديزاين  - ويكيبيديا 
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